
National Geological Database Portal Ver. 1 

User Guide 

 

Contents 
Overview ................................................................................................................................................. 2 

Key Features ............................................................................................................................................ 2 

Working with NGD Portal Basic Functions ................................................................................................. 3 

Navigating the Map .................................................................................................................................... 3 

Changing the Scale ...................................................................................................................................... 4 

Using the Overview Window ...................................................................................................................... 4 

Selecting Data on the Map ......................................................................................................................... 5 

Obtaining Information about Features ...................................................................................................... 5 

Performing Measurements on the Map .................................................................................................... 6 

Working Map Content Layers & Legend .................................................................................................... 6 

Working with the Data Window and the Clipboard ................................................................................ 10 

Showing Client Location ........................................................................................................................... 14 

Sharing a Map ........................................................................................................................................... 14 

Using Advanced Features ....................................................................................................................... 15 

Performing Analyses on Vector / Feature Data ....................................................................................... 15 

Creating and Saving User Maps and Workspaces .................................................................................... 20 

Printing Maps in Geospatial Portal .......................................................................................................... 23 

Displaying Vector Data on the Map Dynamically .................................................................................... 25 

Browsing NGD Datasets | EXPLORE Data Catalog ................................................................................... 26 

Working with the Search Result Panel ..................................................................................................... 27 

 

 

 

 

 

 

 

 

 



Overview 
 

National Geological Database Portal from Saudi Geological survey is a Web-based geospatial data portal 

application that acts as a client for geospatial and geosciences information & services. It is used to find, view, 

and query geosciences data of the Kingdom published by SGS as web services & maps and to integrate multiple 

sources into a single map view that can be easily navigated. 

The NGD Portal simplifies the process of finding, connecting to, and displaying spatial data published through 

Web services. It ensures smooth browsing through intuitive navigation controls and technical advances such 

as asynchronous communication, which ensures that panning and zooming are not interrupted by having to 

wait for servers to respond. The client’s utility is enhanced by additional tools such as measuring area and 

distance, controlling the appearance of individual map layers, and saving and recalling the current map 

context. 

Key Features 

The following are key features of NGD Portal 

 View Published Geological, Mineral Occurrences & SGS Topographic Maps 

 Simultaneously display maps from different map layers, including the transparency adjustment for a 

single layer. 

 Print map. 

 Query for Mineral Occurrences Database. 

 Query for datasets in the National Geological Database Catalog. 

 Provide intuitive mouse control for simple map navigation and better user experience. 

 Measure distances and areas with measuring functions within the map: 2D. 

 Save and restore current maps views 

 Show overview window. 

 Search and browse data (raster, vectors, services, and business data) via Explore Data Catalog Tab 

from National Geological Database Catalog archive 

 Provides 2D map control supporting the display of a base map and rendering other supported data 

sources properly. 

 Multilingual. 

 

 

 

 

 

 



Working with NGD Portal Basic Functions 
 

Navigating the Map 

Navigating the maps displayed in NGD Portal is intuitive and can be performed in many ways using different 
tools. Besides navigating the map with a mouse, you can use tools such as Navigator, Zoom in/out, and Zoom 
by rectangle, or the buttons that allow you to view the previous/next map state. 

All tools for navigating the map are available on the toolbar except Navigator, which is located in the upper-
left corner of the map window. 

You can use one of the following methods to navigate the map in 2D mode: 

 Panning around with a mouse. To move the map, hover over the map window. The mouse cursor 

changes to a hand . Click and hold the left mouse button to move the map. Release the mouse 
button to finish shifting the map and to set a new view. 

 Use the Navigator. Hover over the Navigator and click the Navigator buttons to move the map 
around. With the Navigator you can move the map in four directions (N, E, S, W). 

 

 Click Previous map view and the Next map view to return to a previous map view or to go 
to the next map view (these buttons are not available in 3D mode). 

 

 



Changing the Scale 

You can change the scale of the map in several ways, as follows: 

1. Use Zoom in or Zoom out on the Navigator toolbar: 

o Click to zoom in. 

o Click to zoom out. 
2. Use the Navigator slider rule. To zoom in, move the slider up. To zoom out, move slider down. 

3. Use Zoom by rectangle to draw a rectangle on the map. The map fits to the drawn shape. Zoom 
by rectangle works only in 2D display mode. 

4. Use Set the map scale and type a value for the map scale denominator in the field 

.  

5. To restore the default map view (scale and bounding box), click Fit all .  

6. Click Previous map view and Next map view to return to a previous map view or to go to 
the next map view. 

7. Use the mouse scroll wheel. 

 

Using the Overview Window 

The Overview window shows the range of the current map view on the thumbnail map. It can be used for 
quickly moving your position on the map. 

 

To change the display area you simply draw a rectangle with the cross-hair cursor in the Overview window, or 
move the rectangle by holding its edge with the hand-style cursor. 

In the context menu (available under the down arrow) in the Overview window, the following additional 
settings are available: 

 Translucency – A translucency level for the Overview window can be set with the slider or by typing 
a value in the field. 



 Zoom – Use to adjust the range of the displayed map. The zoom level changes when you select Zoom 
and set the appropriate scale factor. 

Selecting Data on the Map 

Tools for selecting objects displayed on the map are grouped on the Selection tab. You can select objects by 
clicking on a selected object or by drawing different types of geometries. 

 

The following functionalities used for selecting objects are available in Geospatial Portal: 

Icon Name Description 

 

Select features by point  Selects all locatable objects in a designated point. 

 

Select features by polyline Selects all locatable objects that intersect with drawn 
geometry. 

 

Select features by polygon Selects all locatable objects within the drawn geometry 
and intersecting with it. 

 

Select features by rectangle Selects all locatable objects within the drawn rectangle 
geometry and intersecting with it. 

 

Add selected features to clipboard Adds the selected features to the clipboard. 

 

Clear selection Removes all selections from the map.  

In order to add another features to selection press CTRL or SHIFT key and use any of selection tool. To remove 
one or more features from selection press right ALT key and use any of selection tool available in Selection 
toolbar. 

Objects on the map can also be selected by single clicking on the desired object when the mouse cursor is in 
the arrow state. Selected objects can be added to the clipboard to further work with the data. 

 

 Functionality for selecting objects is available only for vector features drawn on the map as result of 
the search / analysis query.  

 

Obtaining Information about Features 

The Feature Info command lets you obtain information about the objects displayed on the map. 

To open the property dialog box for a feature selected on the map, go to the Tools tab on the toolbar and click 
the Feature Info command. When the cursor changes to a cross hair, click on the object on the map. 



Performing Measurements on the Map 

Geospatial Portal provide a range of tools for performing measurements on the map. The measurements can 
be performed in both Geospatial Portal view modes: 2D and 3D. Tools for measuring distance, area, and points 
(read point coordinates) are grouped on the toolbar in the Measurements tab. 

Icon Name Description 

 

Measure point  Lets you read the geographical coordinates of a 
designated point. Coordinates of a point are displayed on 
the map. 

 

Measure distance  Lets you measure the distance between two points or 
multiple points. 

 

Measure area Lets you measure the polygon area. Distance between 
points is also measured. 

 

Clear measures Clears all measurements from the map. 

 

Show/Hide 
Measurements 

Toggles on/off the visibility of labels with the values for 
the measured objects. 

Below are the pictures showing the sample measurements performed on a 2D map. 

5 

The measurements can be performed in metric or imperial units. User can choose the type of units on 
the Settings tab using the System of measurement pull down list. 

Working Map Content Layers & Legend 

The legend for the maps displayed in the map window is shown in the Map Content panel on the Sidebar. 
Here you can manage your legend, change the layers order, modify a layer styles, and perform other tasks 
concerned with the map view in the map window. 

Map content consists Layers. 

In the Layers tab, the layers that are currently available in the map window are shown. 

The order of items in the Layers tab reflects the sequence of layers corresponding to the items on the map. 
The first element (top) in the list corresponds to the top layer on the map. 

To change the order of the layers on the map, use drag and drop to change the order of the 
corresponding elements in the Layers tab.  



You can control the display of a layer with a check box next to the layer name. Check the box to display 
the layer and clear the box to turn off the corresponding layer on the map.  

Layer properties such as display mode, locatable, translucency, and format can be set in the Layers tab. The 
properties possible to be set depend on the service (data source). All settings for layers are accessible from 
the context menu for the selected item. 

 

The following features and commands for layers are available: 

Menu Item Description 

Display mode Sets options for the quality and efficiency for displaying layers on the map. Two 
modes are available: buffer view and tiling. 

Fit layer Adjusts the map window so the entire layer is visible. 

Locatable If enabled, highlights and selects features on the map. This is required for the 
Feature info command to work properly. 

Translucency Defines the transparency for the layer. 

Format  Changes the format in which data is presented on a map, for example, .png, .jpeg, 
.svg, .svgz, and .gif. 

Rename Changes the name of the layer. 

Remove Removes a layer from the Map Content. You can also remove layers by selecting 
the layer and clicking Delete. 

Filter Filters the vector data by attribute values. It applies only to data derived from 
sources such as Analysis / Vector Map Services 

The graphic indicator (  icon), along with a message that appears when you hover over the entry, is shown 
in Map Content if the number of objects displayed on the map is limited by the MaxFeatures parameter for 
Vector Data service. The message for the MaxFeatures indicator shows what the limitation is. 

 



 

In case more restrictions apply to a given feature class (for example, the data is out of scale), the message for 
the MaxFeatures limitation will be visible only when you hover over the graphic indicator icon. Messages for 
other limitations will be displayed when you hover on an entry in the legend. 

Changing the Layer Display Style 

To change the display style for a vector data layer coming from Advanced Spatial Search or Mineral 
Search / Analysis from the Legend in Map Contents: 

1. Double click on the pictogram for the selected layer The Style dialog box opens. 
2. In the Style dialog box, choose the geometry type appropriate for a given layer (for 

example, the area style as shown in the picture below), and select the style type to be 
defined. 

3. Define the style using the available controls, such as Width, Translucency, Color or Line 
Type 

 

4. After defining the style properties, click Apply. 

The functionality for changing the style for displayed layers is accessible only for layers that 
come from services which support style changing and not all Map Layers. 



Layer Filtering 

Vector data that comes from data sources such from Spatial Search or Minerals Search  can be 
filtered in the map window. The filter can be set separately for every feature class layer. Objects 
can be filtered in the map window using the attributes available for them. 

To define an attribute filter for a displayed layer: 

1. Open the drop-down menu for the selected layer, and then select Filter to display a list of 
attributes for a given feature class.  

 

2. Select an attribute for filtering, type the appropriate attribute value in the field, and then 
click Apply to filter the map data. 

3. The filtering operation is based on a simple filtering with the equal to attribute operator. 

Attribute operators such as greater than and less than can be available for some attributes 
(other than text type). Depending on the attribute type, the field for providing their values 
may vary. For some services, for example WFS, only one operator – equal to – is available 
regardless of the field type. 

Below is the sample of the filter field for text and integer type attributes. 



 

 

If more than one attribute is selected for filtering, the logical operator for the selected 
attributes is AND. 

4. To cancel the filter, click the button next to the Filter menu. 

 

Working with the Data Window and the Clipboard 

In the data window, you can display feature classes and attribute values for selected data sources 
(for example: mineral Occurrences Database from Advanced Spatial Search for quick search from 
SEARCH MINERALS tool). 

1. To open the data window, click Data window on the Tools tab. 



 

2. To display data in the data window, from the Classes and queries list, select the items to be 
added to the data window and click Add. 

Data in the data window is presented in tabular form. One window of data can contain 
many tabs with displayed data. Data for one class is presented on a single tab. 

Each data view lets you: 

o Sort data by selected attribute (column) 
o Hide and un-hide selected columns 
o Change the column size 
o Change the column order 
o Select a number of rows (data records) 

Use commands from the context menu for each column to sort the data and to select 
columns to be displayed. 

 



Selecting records in the data window will automatically highlight the corresponding objects 
on the map, on condition that they have been previously displayed in the map window. 
Depending on the option you select in the Settings tab > For items in select set group, you 
can do the following: 

o View objects at the current scale 
o View objects in the center of the map window at the current scale 
o Match a view to the selected object and zoom in by a specified value 

In a data window you can also: 

o Add selected features to clipboard 
o Export all features to a CSV file 
o Export the selected features to a CSV file 
o Show the properties form for the selected feature 

(Some of the tools are currently restricted in the Public Version of NGD v1. They may be 
provided in the future versions.) 

The following functions are grouped at the bottom of data window: 

o Navigate between pages of the data window. Click the arrows or type the required 

page number in the box . 
o Move selected features to the clipboard. To move the selected feature to the 

clipboard, select records in the data window, and click Add to clipboard . To 

refresh the data window, click Refresh . 
o Export data from a data window to a CSV file. To export, click Export all features to a 

file or Export selected features to a file .   

(Export Tools is currently restricted in the Public Version of NGD v1. They may be 
provided in the future versions.) 

 

For each tab of the data window, buttons to perform the following actions are located in the 
Action column:  

o Properties - Click to view the feature Properties window. 



 

o Add to clipboard - Click to add single features to the clipboard. 

o Zoom - Click to zoom to the selected feature on the map. 

o Remove - Click to remove a selected feature from the database of connected 
service (This functionality does not work as data sources are secured read only) 

For some sources (for example, Spatial Searches), you can move features and query results 
to the clipboard. Features from the data window can be moved to the clipboard individually 
or in bulk. Data in the clipboard is presented on the Clipboard tab. Records in the Clipboard 
are grouped in tables. All records from one feature class are presented in one table. 

The following operations are possible for data in each table: 

(Some of the tools are currently restricted in the Public Version of NGD v1. They may be 
provided in the future versions.) 

o Remove all objects from the clipboard 
o Remove selected objects from the clipboard 
o Export selected objects to a CSV file 
o Export all objects to a CSV file 

Removing objects: 

 To remove all objects from tables in the clipboard, click Remove all features from clipboard 

. Buttons used for removing objects are available for each table and can be applied only 
for data from the common table. 

 To remove data from all tables in the clipboard, click Clear clipboard . 

 To remove single records from a table in the clipboard, click Remove from the clipboard 
in the Action column. 



Showing Client Location 

Click Where am I? to show your location on the map. This option is available on the Tools tab. 

This feature uses the location mechanism of the Web browser in which the Portal is run. 
Location method depends on the algorithms used by the particular Web browser and applied 
device settings, particularly on mobile devices the location can be based on GPS and/or Wi-Fi & 
mobile network.  

Where Am I? feature in Portal running on the Chrome, Firefox, Opera and iOS Safari Web 
browser works only with secured connections (HTTPS). This restriction applies only to the Chrome 
Web browser starting with version 50, Firefox Web browser starting with version 55, Opera starting 
with version 39 and iOS Safari starting with version 10.2 as the geolocation is no longer supported 
on non-secured connections.  

Sharing a Map 

The Show a link to the map command provides a link that is a reference to the current view of the 

presented map. To get a link to the map, on the Tools tab, click . 

Portal window adapts to the screen resolution/ browser / tiled services composed in the map, 
so the exact map range may not be available while sharing link to the map. It is still possible to use 
the Link command from User Maps feature (see Creating and Saving User Maps and Workspaces). 

 

 

 

 

 

 

 

 

 

 

 

 

https://ngp.sgs.org.sa/GeospatialPortalDoc/Guide/en/#User_Maps.htm


Using Advanced Features 
 

Performing Analyses on Vector / Feature Data 
 

The Analyses panel called Advanced Spatial Search on the sidebar lets you perform a series 
of attribute or spatial queries on vector data from the selected / configured data sources. 

Currently Mineral Occurrences Database has been deployed to NGD Portal for Advanced Spatial 
Search / Analysis, in later subsequent version more Databases will be available overtime. 

 

A. Defining and Executing Analyses 

To perform a new analysis from Advanced Spatial Search Panel 

1. From the first top drop-down list, select Create new option.  

Create new is a default option. If no queries were performed, only the Create new 
value is available. 

2. From the Select features in drop-down list, select the feature class for which to perform 
analysis. 

3. Set the analysis parameters: 
1. Check Where filter is to perform an attribute query and to set the required 

parameters. 
2. Check Spatial filter to perform a spatial query and to set all the required parameters. 

Available spatial and attribute parameters and operators may vary depending on the 
data source type. The features can be filtered spatially with current map window, drawn 
geometry and selected features using available operators (for example intersects, overlaps, 
touches, contains, disjoint, crosses etc.). 

4. Type a name for the analysis layer, and set the style in which the results should be 
presented on the map. 

5. In the Display field, specify the query name. This name is visible in the Map Content tab. 
6. To change the style in which the analysis results are displayed on the map, check With style 

and click . If the style is not defined, the data is presented with a default style. 
7. Click Execute to perform an analysis. 

Data appears in the map window and in the Map Content tab. Response time depends on 
the quantity of data that is loaded. 



 

 

 When performing attribute queries on data coming from WFS service, an additional IN and 
NOT IN operators are now available in User Interface. 

 IN and NOT IN operators are not a part of neither OGC WFS nor OGC Filter Encoding 
specification. They were introduced in the User Interface for practical reasons and in case of 
WFS they are implemented as multi-level OR queries. Values should be comma separated in 
the input field. 

 

 

 

 

 

 



B. Updating Analyses 

Once executed, analysis can be altered and updated according to your needs. You can freely change 
the parameters set for the analysis and can immediately see the updated results on the map and/or 
data window. 

To update an analysis: 

1. Go to the Analyses tab. 

2. From the first drop-down list, select an analysis to update. This list is populated with 
all executed analyses. (In case no analyses have been performed so far, only the Create new 
option will be available.)  

 

All fields for the Analyses dialog box are populated with values used for earlier performed 
and selected analyses. 

3. Alter the required parameter values for the selected analysis. You can also change 
the parameter used for a given analysis and change the display style and name if needed. To 
clear all fields, click Clear. 

4. Having provided all changes to the analysis definition, click Update. Results of the 
analysis will be updated according to the set parameters and their values. In Map Content, 
the entry for an altered analysis will remain unchanged (except for the pictogram and the 
layer name provided that modified). 

The button Update changes to Execute when the Create new option is selected. 



 

 

It is also possible to select an analysis to 
update directly from the Map Content tab. 
For a selected analysis layer from the context 
menu, select the Update analysis option. The 
Analyses tab will be automatically opened 
with all fields filled in for the selected query. 

 

 



Deleting an Analyses: 

All executed analyses are kept in Portal (unless you refresh the application) and can be modified 
and/or displayed later, even if they were earlier removed from the Map Content and/or Data 
Window. 

Analyses that are no longer needed can be deleted permanently. In order to do this, select the 
analysis to be removed, and click Delete on the bottom of the dialog box. 

The Delete button is available on the form only if an analysis is selected from the list. 

 

 

 

 



Creating a new analysis based on an existing one 

In order to create a new analysis based on an existing one: 

1. From the top pull-down list, select the analysis to be the base for a new one. All 
fields in the dialog box will be filled in with values proper for the selected analysis. 

2. Modify any required parameters if needed. 

3. From the top pull-down list, select Create new. The button Update changes to 
Execute. 

4. Click Execute to create a new analysis. 
 

Creating and Saving User Maps and Workspaces 

Registered and logged in users can save their own map compositions and workspaces. Workspaces 
and maps are stored in a user profile and are immediately available after user log on, but they also 
can be saved to a file. The user profile data are stored on the server where Portal is installed and 
instantiated. A map is a single composition of several layers that may come from different data 
sources; a workspace can be understood as a container for several maps. The User Maps feature is 
used to save maps and workspaces within a configuration. 

To add a Workspace or Map: 

1. Click User Maps on the Tools tab. The User maps window opens. 

2. In the User Map window, you can add and manage single maps and workspaces (a 
collection of maps). 

You can add maps and workspaces as follows: 

a. Add from the map window: 

To add a map or workspace from a map window: From the User maps dialog box, 
Maps/Workspaces menu, select Add > From map. This method lets you save the state 
of all displayed layers and the extents for all map variants. 

Save credentials of connected data sources option - If enabled, saves all credentials 
for authorized services used in a created map or workspace. If the option Save 
credentials of connected data sources was enabled while creating the workspace or 
map, Portal will try to load and initialize all services with the credentials saved and 
used earlier. If the provided credentials fail, an attempt to initialize services as an 
anonymous user will be made.  

When another map is added to the existing workspace with the Save credentials 
of connected data sources option, the credentials will be saved for the whole 
workspace (even if previous maps have been added to the workspace without 
credentials). 

 

 



b. Add from an exported file: 

To add from an earlier exported file: From the User maps dialog box, 
Maps/Workspaces menu, select Add > From gpm/gpw file. 

A map file has the .gpm extension, and a workspace has the .gpw extension. 

The Add command is not available in the context menu for single maps within a 
created workspace or for single maps in the Maps group. 

3. The workspace within a map(s) or a single map is saved and kept in the logged Portal 
user profile on the local machine cache only in this version 1. 

Since current Version of NGD portal does not have user registration process and is open public 
data visualization, hence the save of workspaces and maps is supported for local machine / browser 
only. If the cache is cleared the saved maps are cleared as well. 

 
User Maps and Workspace Functions and Commands: 

Maps and workspaces have a menu with the following functions and commands: 

 Display – Displays selected maps or workspaces.  

When displaying the workspace, the default (first) map will be shown in the map 
window and Map Content, but the map selector (drop-down list or buttons depending on 
the Geospatial Portal configuration) will be populated with all maps from a given workspace. 

 Public – Activates the Link function and makes the map public so that it is possible to 
share it among other portal users. 

Always make your workspace or map public if you intend to use them in the starting 
configuration. 

 Link – Gives you a direct link to a map that can be forwarded to another user. Also 
returns the workspace or map ID that can be used in the Administration Console while 
preparing the starting configuration for Geospatial Portal. 

 Download - Saves the workspace or map to a file. 

 Rename – Changes the name of a map or workspace. 

 Remove – Removes a map or workspace. 

 Properties – Sets such properties as Map ranges, Predefined scales, Scale bands, 
and Scale ranges 

 Map ranges – Map ranges (bounding box) for common coordinate systems 
are used by the Fit all function. When you display the map and click Fit all, the map 
area is adjusted to the extent specified in the fields [X min], [Y min], [X max], and [Y 
max]. 

 Predefined scales – Lets you add predefined scales for saved maps. When 
you display a map with predefined scales, a predefined list appears in the field for 
changing the scale. You can also give any value of the denominator of the scale in 
the box. 



To add predefined scales, select Properties for the map. On the Predefined scales 
tab, click Add and type a scale denominator. Click Save. Next display the map (by 
selecting the Display command). A drop-down list with predefined scale options is 
provided. 

 

 Scale bands – Lets you specify the scale in which different layers of the map 
will be displayed. To add a scale band, click Add and provide a name for the scale 
band and scale denominator. You can decide which layers should be displayed in 
which scale bands. To do this, run the tool for the scale band settings in the Tools 
toolbar.  

 Scale range – Lets you specify a range of scales in which the entire displayed 
map is available, regardless of scale band settings for single layers. Data can only be 
shown on scales containing values between the minimum and maximum scale that 
you specify. 

For a workspace, the Properties command allows you to add/remove the Coordinate 
Reference System and to define such parameters as axes direction and whether the given CRS 
is geographic or not.  

The CRS list in the Coordinate reference system tab corresponds to the coordinate system list 
on the Settings tab. You can add a CRS or remove a CRS from the Coordinate reference 
system list by using the Add and Remove buttons. The Add button opens a Spatial Reference 
System where you can find and add coordinate systems to the list.  

Once the CRS is added for the workspace, the appropriate entries (CRS) appear in the 
properties for all child maps for the given workspace in the Map ranges tab. Displaying the 
workspace using the Display command automatically adds the CRS, defined for this 
workspace, to the Coordinate System list visible on the Settings tab in the Sidebar. 

Current version of NGD Portal does not have Settings sidebar available to change coordinate 
system. All the data layers are visualized in Transverse Web Mercator Project (EPSG:3857). 

 

 

 

 

 

 



Printing Maps in Geospatial Portal 

Printing a map in Portal can be performed with any of the connected print services.  

The Portal does not provide a mechanism for printing a hard copy but printing to a file can be done. 
Printing to a file is similar to printing a hard copy, except that it generates a printer file instead of 
routing the document directly to a printer. This provides a method for generating soft-copy files 
that can be stored on disk and printed or plotted as necessary without having to be in the 
application to resubmit the plots.  

In order to open Print Map dialog: 

1. On the Tools tab from the toolbar, click Print Map . 
2. The Print Map dialog box is displayed, and a red semi-translucent rectangle appears on the 

map. The rectangle shows the area to be printed. 
3. In the Print Map dialog box, select the following: 

o Common Option tab: 
 Print service – Local for the Geospatial Portal internal printing. 
 Format – Graphic file type into which the map you are printing will be saved.  
 Template – Print template. Predefined templates are available. 
 Page size – Select the page size from available sizes in the pull-down list. 
 Orientation – Options include Landscape or Portrait. 
 Scale – Provide the scale for the printed map. 

o Template Options tab: 

Data provided for the attributes listed below will appear on the print. 

Options offered by the selected template: 

o Display Legend (Checkbox) 
o Map Title 
o Produced By 

4. Legend tab 

The Legend tab is used to select the layers that appear in the printed legend provided that 
selected elements appear on the map. In case some elements are selected on the Legend 
tab but corresponding layers are not displayed on the map (turned off in the Map Content), 
these elements will not appear on the print in the Legend section. 

 

 

 

 



The rectangle (printed area) size changes when you change the page size, orientation, 
or scale. 

 

5. Move the rectangle to precisely select the map area you want to print. 
6. Click Print to create the graphic file to be printed. 

 

   

Common Options 

Format PNG; XPS; GIF; JPEG; TIFF; BMP 

Template Sample landscape template with all data filled;  

Sample portrait template with all data filled;  

Page size A0; A1; A3; A4; A5 

Orientation Depends on selected template (Landscape or 
Portrait) 

Scale Predefined scale selectable from the pull-down list 

Legend (user can decide which map layers 
appear in the legend) 

Yes 

 

 

 

 



Displaying Vector Data on the Map Dynamically  

The Dynamic Object View function is used for dynamically viewing spatial data served by services 
such as Vector Feature Data Layers, like Mineral Occurrences Database Features 

To display spatial data using Dynamic Object View: 

1. On the Tools tab, click Dynamic object view. 
2. In the Dynamic object view window, from the Feature class drop-down list, select a feature 

class which should be displayed. 
3. In a Tooltip field, select an attribute which will be visible as a tooltip for the displayed 

object. 
4. Define a style for the displayed objects on the map using the control for changing the style 

available in the Dynamic Object View window. 
5. To display a region with a cable, click an object on the map. 

To determine how objects are loaded, select one of the following options: 

o Display only features under the mouse cursor – Every time you move the cursor on 
the map, the features are loaded and displayed.  

o Display all features – Loads all available features to memory; then the objects are 
displayed in the chosen location. 

 

 

 

 

 



Browsing NGD Datasets | EXPLORE Data Catalog 

On the EXPLORE Data Catalog panel, you can browse for all the data that you are able to access 
through the Web Client. 

In the EXPLORE Data Catalog tree, the following elements may be listed depending on conditions 
that exist in the catalog: 

 Services 

The Services node shows all of the service providers that you can access through the Web client. 
These service providers are categorized by the type of protocol used. 

 Vectors (WFS) - Web feature service providers. The name of the top-level node for each 
WFS is set to the title property of the WFS. As the WFS specification provided by the OGC 
does not support nesting of feature types, child nodes corresponding to layers and are 
organized in a flat format.  

 Maps (WMS) - Web map service providers. This node includes all WMS providers that have 
been added as well as the base map that is being used in the maps panel. The name of the 
top-level node for each WMS is set to the title property of the WMS (which is shown in the 
GetCapabilities document for the WMS). Child nodes correspond to layers and are organized 
in a hierarchical format, in accordance with OGC specifications for WMS. 

 Coverages (WCS) – Web coverage service providers. The name of the top-level node for 
each WCS is set to the title property of the WCS (which is shown in the GetCapabilities 
document for the WCS). 

 Coverage Catalog - Contents of the ERDAS APOLLO Server catalog that is associated with 
this Web client. 

All of the datasets and aggregates in the catalog are shown as nodes under the ROOT aggregate for 
the catalog. You can open an aggregate node to see the child aggregates, if there are any. If you 
click on an aggregate, the Results Panel will display more information about the aggregate and a 
list of the datasets that it contains. 



 

 

Detailed information about selected items from the catalog are displayed in the bottom Search 
Result panel, where you can perform some actions such as adding to the map, viewing metadata, 
displaying the spatial extent of data on the map/ 

To refresh the directory tree and to see the changes made in the EXPLORE Data Catalog, click 
Refresh in the lower-right corner of the tab. 

Working with the Search Result Panel 

The Search Results panel shows detailed information about the data that you can access through 
browsing or searching the NGD Datasets Catalog. Search Results also provides different buttons 
that allow you to perform specific tasks with the found data. 

The listing for each result displays the name of the result. Each listing also displays certain metadata 
for each result, including the title, abstract, compatible Web services, acquisition date, SRS, and 
spatial extent. 

To see a specific extent for the found data, click the extent hyperlink (Details View only). You could 
alternatively select one or more search results and choose the Zoom command from the toolbar to 
change the map range so that it fits to the extents of all selected items. To highlight the spatial 
extent of the result on the map, move your mouse over the listing. 



For found Datasets and Business Data, an additional option, File link:Open, can be available in the 
Search Panel. Clicking this option for the selected item downloads the file or opens it automatically 
in the application associated with the file type.  

Data in all tabs can be presented in two different display modes: 

 Details 
 Thumbnails 

To change the display mode for data presented in the tab, use the View drop-down menu in each 
tab. 

 

 

 

Actions Performed on the Search Result Panel 

Each Search Result tab contains a top-action toolbar with a certain set of action controls either in 
the form of text buttons or combo boxes. These actions can be performed on the Catalog data, 
selected in the Search Result panel. Selected items are indicated by a red, vertical line on the left 
side. Default possible actions for Portal are described below. 

 

Add To Map 

Adds the selected element to the Map Content tab and the map window. You can add more than 
one result to the Map Content tab and the map window. 

Selected item or items can be added to the map using different protocols. These protocols are 
WMS, WMTS, and ECWP. Notice that for some data, the list of available protocols may be limited. 



In order to add selected items to the map using the desired protocol, open (by clicking the down 
arrow) the context menu for the Add to map button, and select the protocol from the list. The data 
will be added to the map with the selected protocols. 

For OGC WFS services, the option Add as Vector is used to add data from WFS services to the map. 

You can add an item straight to the map without selecting the protocol by clicking Add to map 
(without expanding the context menu). In this case, the application determines the best protocol 
for the selected items. 

 

For services such as OGC WMS or OGC WFS, the Register in Portal, Display All, and Display 
Selected commands are available under the Add to map button. The Display All command registers 
and adds the selected service to the Map Content, while Display selected registers the service and 
opens the Add to legend dialog box, where you can choose features to be displayed.  

 

Metadata 

The Metadata button on the search action toolbar groups all commands for displaying and 
downloading metadata for elements from the search panel. 

 



Index Metadata 

Displays, in a separate window, the whole set of coverage metadata for the selected search results. 
Metadata for each selected element is displayed in a separate tab.  

ISO Metadata 

Displays a window containing the original ISO 19115 metadata using ISO 19139 XML encoding. This 
document can contain additional metadata. Metadata for each selected element is displayed in a 
separate tab. 

Download ISO XML 

Downloads an XML file containing ISO Metadata. 

Add To Clip-Zip-Ship 

This action adds the selected items from the Search Result panel to the Clip-Zip-Ship tab, where 
the Clip-Zip-Ship process can be performed. (For more information, refer to the Clip-Zip-Ship 
section.) 

Download 

Current version of NGD Portal does not have Download Capability enabled.  

Sends a message to the provided email address with a link to download the original file. If multiple 
search results are selected, a separate link for each file to download will be included in the sent 
message. The email address must be entered into the dialog box that appears after clicking 
Download. This functionality applies only to datasets and coverages. If the file to download exceeds 
the size defined by the Administrator (by default it is 100 MB), the information that the file is too 
big to download will be displayed. 

Zoom 

You can select one or more search results and choose the Zoom command from the toolbar to 
change the map range so that it fits to the extents of all selected items. The range is changed to the 
maximum possible zoom level that maintains each selected result extents in the view. This action 
works for all search results that have proper extents available. 

Display style & Highlight style  

You can define the style in which footprints are displayed and highlighted when you move the 
mouse cursor over a footprint. The display and highlight style for footprints can be changed with 
the Style dialog box, on which you can define the appearance for a footprint boundary and fill. 
Footprint style can be defined by parameters such as line (border) width, line (border) color, line 
translucency, and fill color and translucency. Pattern fills are also applicable. In order to open the 



Style dialog box for the footprint display style, click the Display style pictogram . To define 

highlight style, click the Highlight style pictogram. 

View 

This option allows you to set the thumbnail or detailed view in the Search Result panel. 

GeoRSS 

The results in the Search Result panel can be exported to GeoRSS. By doing so, the resulting 
GeoRSS resource will represent a feed that can alert you any time a new resource matching that 
query is registered in the catalog. By pressing the RSS feed icon, two actions are available:  

 Search results as GeoRSS – Displays a browser dialog box with a link to the GeoRSS, which 
can be used in third-party applications and RSS readers. Depending on the Web browser and 
its components, the functionality, appearance, and behavior of the dialog box may vary. 

 Register as GeoRSS – Automatically registers the GeoRSS based on the search results in 
Geospatial Portal. The GeoRSS is registered with the default refresh setting, and a layer is 
added to the Map Content. 

 

Live 

This option ensures that only elements that cover the actual map range are shown in the Search 
Result Panel, and the result list is updated automatically during every map move. To protect the 
server from overloading, the 1,5 second delay buffer is set for all outgoing requests. Click the Live 
button to enable this functionality.  

Access 

For some search result types, such as Datasets, MapLayers, or Vector Layers from Catalog, the links 
for Access attribute are displayed. 

The table below shows the link name depending on the link type and action performed after a click. 

Search result type Displayed link name After click action 

FeatureType WFS DescribeFeature 

MapLayer WMS GetLayer 

Dataset (wmsEnabled) WMS GetLayer 

Dataset 
(wmtsEnabled) 

WMTS Display WMTS 
capabilities 

Dataset (czsEnabled) CZS No action 



Dataset 
(ecwpEnabled) 

ECWP Display using ecwp 
plugin 

 

 

Navigating the Search Results Item in the Search Result Panels 

If there are many results from the search, the results will be shown on different pages. Using the 
Items per page drop-down list, determine how many results you want to display on the page. The 
possible values are 50, 100, 150, 250 and 500.  

The page numbers will be shown along the bottom of the Search Results panel, and you can click 

on the page numbers to see the results listed on that page, or you can use buttons: Next page 

, Last page , First page , Previous page to navigate between pages.  

To refresh the Search Results panel, click Refresh . 

Use to select all results in the Search Results panel; when all results are selected, the 

button changes to . 

 

Icons for Search Results 

Below is the list of icons for specific search items to be used in the Search Result Panel: 

Datasets 

  

Imagery 
 

Vector 
 

Document 
 

Point Cloud 
 

Service Layer 

  

Map (WMS) 
 

Vector (WFS) 
 

Coverage (WCS) 
 

Service 

  

WMS 
 

WFS 
 

WCS 
 

 

 



Footprints 

Footprints – outlines showing the data extent – for all search results from the current tab are 
automatically displayed on the map. When a mouse cursor is moved over any item in the Search 
Result panel, the corresponding footprint on the map is automatically highlighted. Whole footprints 
must be within view in order to be highlighted (this prevents over-flooding the map window with 
unwanted highlights). When clicking a footprint on the map, the results get selected in the Search 
Result panel. While selecting overlapping footprints, the context menu with footprint names will 
appear where you can check elements to be selected in the Search Result panel. 

 

The footprints are not displayed for search result items without geometry. 

You can define the style in which footprints are displayed and highlighted. The display and highlight 
style for footprints can be changed with the Style dialog box, where you can define the appearance 
for footprint boundary and fill. Footprint style can be defined by parameters, such as line (border) 
width, line (border) color, line translucency, and fill color and translucency. Pattern fills are also 
applicable. 

In order to open the Style dialog box for the footprint display style, click the Display style pictogram 
on the Action toolbar. To define the highlight style, click the Highlight style pictogram. Both 
pictograms are located on the right side of Action toolbar on the Search Result panel. 



 

 

Documents Preview 

All documents in the NGD Catalog have their spatial representation on the map and, by default, are 
marked by a red dot. You can change the display style of the spatial representation of documents 
using the Style dialog box for footprints display. A preview for the selected document is displayed 
when you click with the right mouse button on the corresponding dot on the map. The preview for 
the selected document is displayed in the internal Web browser window. In case there is more than 
one object at a given location, a menu will be displayed that allows you to select the object 
(document) to be viewed. This functionality works only for the objects natively supported by Web 
browsers such as Adobe PDF files, images, and flash. All others that are not supported by Web 
browser documents will be downloaded. 

For some datasets and documents shown in the Search Result Panel, an additional option, File 
link: Open, is available. Clicking this option in the Search Result Panel downloads a selected file or 
opens it automatically in applications associated with the file type. Documents natively supported 
by a Web browser will be opened in a separate Web browser tab. 

 

 

 

 

 


